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To explore a particular part, click on the appropriate button:
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How to Use this Help

Menu Commands
Procedures
Toolbox

Mark Palette
Search Ribbon
Status Bar

Shortcuts & Tips




Menu Commands

Album Menu
Edit Menu
Thumbnail Menu
File Menu

View Menu
Window Menu

Help Menu
Switch Menu
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Related topic
(] Windows Control Menu
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Remove
Update

Batch Manager
Properties

Keywords
Maintenance

Acquire

Select Source
Print

Printer Setup
Preferences
Exit




Maintenance Submenu
Check

Move

Copy
Delete

Rename

Backup
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Restore




Preferences Submenu
Album
OLE & Clipboard
Photo CD
Display

Memory
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File Formats




Print Submenu
Album
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E Thumbnails
3

Keywords
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Related topic
3 Printing an album
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Edit Menu
Undo/Can't Undo

Repeat
Cut

Select
Make Album
Run




Copy Submenu
File
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Filename




#] Select Submenu
= All

= None

= Invert




Thumbnail Menu

Insert

Properties

Move

Search

Search by Item
Search by Query
Search Entire Album
Sort by

Save Sequence

Update

o] o] o] o] ] o] ] e o o o o [ ] o]

Relink




Search by Item Submenu
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E Keywords
E Subjects

Marks




[#l Search by Query Submenu
E List of Defined Queries

More




Sort by Submenu
Name
File Type
Size
Date
Media Type
Subject
Description

Others
User Defined
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= Update Submenu
= From File
= From Clipboard
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File Menu

Convert File Format

Convert Data Type

Attributes

Associate




View Menu
All
Invert
Selected

Scroll To

Auto Scroll
Thumbnails
Filenames

Slide Show

Files

File Information
Album Information

Options
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Options Submenu

=

E Shel

= Hide/Show Toolbox
=

=

=

Hide/Show Mark Palette
Hide/Show Search Ribbon




#l Window Menu
3 Cascade

E  Tile

= Arrange Icons
= Windows List




Help Menu
Contents
Search for Help on
How to Use Help
About Ulead Products
About Album
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# Switch Menu

This menu lists the other MediaStudio programs. Click on a program name and the corresponding
program is invoked. You can also access the Windows Program Manager, File Manager and Clipboard
Viewer.




E Windows Control Menu

Every window has its own control menu in the top left corner to manage the window itself. Some control
menus also contain an additional command such as Next or Run. These commands allow you to swap
between windows.

@ Restore restores a window to its normal size (i.e. the size it was before being maximized or
minimized)

& Move allows users to move the window

@ Size allows users to change the size of the window

& Minimize reduces the window to an icon

@ Maximize enlarges the window to fill all available space (either on screen or within a parent
window)

® Close closes the window

& Switch To brings up the Windows Task List dialog box
@ Always on Top places the Album program or minimized icon above any other programs




Toolbox

The toolbox provides a link between the files you are organizing and your most frequently used
aiilications. Click on the toolbox for more information on each area.

Shelf

Tool button
Scroll buttons

Tool icons

Related topic
3 Customizing the toolbox



Mark Palette

The Mark Palette allows you to mark thumbnails so that you can easily identify your files within an
album. Click on the mark palette or the control menu box for more information on each area.
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Related topic
= Using the Mark Palette



Mark Palette Control Menu

The control menu box in the mark palette allows you to clear and edit marks, load and save mark files.
The commands are as follows:

Move allows you to position the mark palette anywhere within the workspace

Close hides the mark palette

Assign Selected assigns the specified mark to a selected thumbnail

Clear Selected removes the specified mark from a selected thumbnail

Clear All removes the specified mark from all the thumbnails in the album

Edit opens the Edit Marks dialog box in which you can assign or change the mark name
Load accesses the Load Marks dialog box in which you can load a mark file

Save accesses the Save Marks dialog box in which you can save marks to a file

Convert to Keywords opens the Convert to Keywords dialog box in which you can choose to
remove marks from thumbnails and/or clear mark names after converting marks into keywords
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Note: Some of the above commands are not available if no thumbnails are selected. Make sure you
have selected some thumbnails and selected the mark(s) to enable the commands.

Related topics
= Mark Palette
Using the Mark Palette



Status Bar
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In Album, there are two places where the status bar appears: one along the bottom of the Album
workspace and the other, at the bottom of each album. Click on the status bar for more information on

each area.
Note: Double-click on the status bar to display the Album dialog box.




Search Ribbon
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The search ribbon is located below the menu bar. Depending on the search criteria you choose, the
search ribbon changes accordingly. Click on the search ribbon for more information on each area.

Tip: Select "Search Entire Album" in the Thumbnail menu, to start searching for thumbnails without
displaying all the thumbnails in the album.

Related topic
3 Search operations



Shortcuts & Tips

Album has many keyboard shortcuts and mouse actions that save you time and trouble when
cataloging your files in an album. This section lists all the shortcuts including some helpful tips. You may
want to print this topic if you wish to keep a copy for reference.

Click here to print this topic
3 Click here to close this window

Album Menu

Ctrl+ O Displays the Open dialog box
Ctrl + K Checks the thumbnails in an album
Ctrl+P Displays the Print dialog box
Ctrl +B Displays the Preferences: Album dialog box
Ctrl + Q Exits Album

Edit Menu
Ctrl+Z Undoes the last command
F4 Repeats the last applied command
Ctrl + X Cuts selected thumbnails onto the clipboard
Ctrl+C Copies selected thumbnails to the clipboard
Ctrl +V Pastes the clipboard data into an album
Del Removes selected thumbnails from an album
Ctrl +L Selects all thumbnails in an album
Ctrl + N Deselects the selected thumbnails in an album
Enter Launches the application associated with a file

Thumbnail Menu

Ins Displays the Insert dialog box

Alt + Enter Displays the Thumbnail Properties dialog box

Ctrl+ S Displays the Search dialog box

Ctrl+1to 9 Selects a predefined query

Ctrl + W Searches all the thumbnails in an album

Ctrl + F1 Sorts the thumbnails by name

Ctrl + F2 Sorts the thumbnails by file type

Ctrl + F3 Sorts the thumbnails by media type

Ctrl + F5 Sorts the thumbnails by subject

Ctrl+U Sorts the thumbnails by a user-defined sequence
View Menu

Ctrl + A Displays all the thumbnails

Ctrl+D Displays the Scroll To dialog box

Ctrl+T Displays the thumbnails

Ctrl+ F Displays the filenames

Window Menu
Shift + F5 Cascades all the albums in the workspace



Shift + F4 Tiles all the albums in the workspace

Help Menu

F1 Displays the Album Help

Shift + F10 Displays the Microsoft Windows Help
Tool Menu

/ Displays the tool menu

Ctrl + Shift + 1 to 4 Selects a program group

Ctrl+R Displays the Run dialog box

Mouse Actions
Double-click on title bar to maximize or restore the active window
Double-click on search ribbon to display the Search dialog box
Double-click in workspace to display the Batch Manager dialog box
Double-click thumbnail to view/play a thumbnail file
Double-click thumbnail in Thumbnails Properties dialog box to view/play files
Double-click on toolbox title to close the toolbox (only for toolbox)
Double-click on Mark Palette title bar to close the Mark Palette
Double-click status bar to display the Preferences: Album dialog box
Click on an album's status bar to deselect all selections

Click right mouse button on a thumbnail/filename to display an information box (use the arrow keys to
move the information box)

Command Line options
/m or -m : Invokes Album with the last-used album maximized.

/s or -s : Invokes Album in the lower-left corner of the screen with its window size reduced to one-
fourth.

/n or -n : Invokes Album without displaying the MediaStudio logo.
Drag-and-drop operations
Drag execution files (*.EXE) from File Manager to toolbox to insert program icons
Drag album files (*.ABM) from File Manager to Album's workspace to open albums
Drag files from File Manager to an album to insert thumbnails of files
Drag files to an icon in toolbox to open files in that program (if it supports the selected file formats)
Drag files to another application with SHIFT key down for embedding or CTRL key for linking
Drag files between albums to move thumbnails to another album
Drag files to another album with Ctrl key to copy thumbnails
Tips
Uncheck "Enable Automatic Checking of Source files" in the Album dialog box if you find thumbnails
are repainted very slowly.

When in Filename mode, there are two arrow buttons in the status bar to scroll to the left/right of the
window. To speed up scrolling try using the CTRL or SHIFT + CTRL when you click on the arrows.
Double-click on the left button to go back to the beginning.







Shelf

Albums in Workspace displays the titles of albums in the workspace

Albums on Shelf displays the titles of albums on the shelf

=> moves the selected album from the workspace onto the shelf

<= moves the selected album from the shelf into the workspace

Info displays a dialog box containing information about a selected album from either the shelf or
e workspace

Delete removes the selected album on the shelf from Album and deletes the album file from disk
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Related topics

3 Batch Manager dialog box
Using Album's Shelf



Album Properties

= Title allows you to edit the active album's title (up to 23 characters)
= Size changes the size of the thumbnails in the active album
E3 Compression allows you to choose the thumbnails’' compression scheme

Display Thumbnails in Grayscale allows you to display thumbnails in the album as gray
images. This option is only available when you are using a 16-Color display and you have selected
"Bypass VGA palette to enable use of 16 grays" in the VGA Palette dialog box (opened from the
Preferences: Display dialog box)

Description allows you to assign or edit an album's description. (this is optional and can be left

blank)
= Info opens a dialog box displaying information about the active album
= Read Only prevents any changes to be made to the album. Checking this option will disable

some commands

Related topic
3 Changing album properties



Move
= Move to Before moves the selected thumbnails before the specified thumbnail




Relink

Relink Thumbnail Path to:
Drive allows you to relink the selected thumbnails to files in the same directory but on a different

drive

= Directory allows you to define a single directory in which all the files will be found

= Browse opens the Browse dialog box, use this dialog box to search for files
Related topic

3 Relinking thumbnails and files



Thumbnail Properties

= Keywords display the keywords you have assigned to the current thumbnail from the list of
keywords in an album

Subject allows you to enter a subject for the current thumbnail (up to 127 characters)
= Description allows you to enter a description for the current thumbnail (up to 4095 characters).
This is optional and can be left blank

Information displays information about the current thumbnail
Note: You can double-click on the thumbnail to display the file in Viewer or play it in Media Player

= Previous lets you view the previous thumbnail (only available if multiple thumbnails are selected)
= Next lets you view the next thumbnail (only available if multiple thumbnails are selected)
= Go To opens the Go To dialog box in which you can quickly go to a thumbnail you wish to view or
edit their properties
Load opens the Load Thumbnail Properties dialog box in which you can load the properties from

a file
= Save opens the Save Thumbnail Properties dialog box in which you can save the properties to a
file

Related topic

3 Changing thumbnail properties



Go To

= Go to File allows you to directly enter the filename or index number of the thumbnail you wish to
view or edit

Related topic
= Thumbnail Properties dialog box



Save Thumbnail Properties

= File Name allows you to enter a filename or, if you wish to overwrite an existing file, select its
filename from the files list box
List Files of Type shows the file extension for Windows and DOS Text files (TXT). You can use
wildcards (*.*) to display all files in the directory
Directories shows the current path and any subdirectories under that path
Drives lists all the available drives
Keywords option saves only the keywords
Subject option saves only the assigned subject
Description saves only the description
Browse opens the Browse dialog box; use this dialog box to search for files
Network allows you to connect to a network (only available if you are running Windows for
Workgroups)
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Related topic
3 Thumbnail Properties dialog box



Load Thumbnail Properties

= File Name initially shows the TXT extension; if you know the path and name of the file you wish
to load, enter it here or select it from the list box
List Files of Type shows the file extension for Windows and DOS Text files (TXT). You can use
wildcards (*.*) to display all files in the directory
Directories shows the current path and any subdirectories under that path
Drives lists all the available drives
Keywords option allows you to load only the keywords of selected thumbnails
Subject allows you to load only the subject of selected thumbnails
Description allows you to load only the description of selected thumbnails
Browse opens the Browse dialog box; use this dialog box to search for files
Network allows you to connect to a network (only available if you are running Windows for
Workgroups)
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Related topic
3 Thumbnail Properties dialog box



Background Color

= Basic Colors allows you to select a standard Windows color to replace the old one
= Custom Colors lets you add your own color
= Define Custom Colors displays the color palette from which you choose your own color to add

to the custom colors

Note: If you have tried all the options to select colors, you may have noticed that when a dialog box
appears, it is always the same. The only thing that differs is the title bar. Regardless of what color you
want to change, whether background or text color, the basic method for selecting a color is the same.

Related topics

3 Slide Show dialog box
Creating a slide show



Slide Show Text

Display allows you to display text information in the slide show

Location allows you to choose where the text will appear on the screen

Alignment lets you align the text on the left, right or center

No. of Lines allows you to select the number of lines to display the text information

Fonts opens the Fonts dialog box in which you can change the typeface of the text

Color opens the Set Color dialog box to set the color of the text

Display Index Number when selected allows you to display the filename with its index number
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Related topics

= Slide Show dialog box
Creating a slide show



Slide Show

Transition

Effect allows you to choose the transition effect applied in a slide show
= Speed sets the speed at which the effect is applied

Delay sets the delay in the transition from one 'slide' to another
= Synchronize With Audio Files plays any selected sound files in synchronization with image and
%Iaphics files

Manually With Keyboard or Mouse allows you to manually control the slide show presentation.
The manual controls dialog box is displayed after you have selected this option and pressed OK
= Continuous Repeat displays the slide show in a continuous loop until press the Esc key
= Resize Large Images to Fit Screen Size shrinks large images and graphics to fit in the screen.
Images and graphics which are smaller than the screen size will not be resized

Use a Common Palette to Show Images displays original images and graphics using a
common display palette

Hide Pointer During Slide Show hides the pointer during the slide show

Text opens the Slide Show Text dialog box in which you can select the typeface of the text
information
= Bkgd Color opens the Set Color dialog box in which you can change the background color
= Bkgd Music opens the Background Music dialog box in which you can select MIDI files to be

layed during the slide show

Load opens the Load Slide Show dialog box to load a slide show file

= Save opens the Save Slide Show dialog box to save a slide show to a file

Related topic
= Creating a slide show



Background Music

= List of Files to be Played lists the selected MIDI files to be played during the slide show
= Repeat Background Music After Slide Show Finishes plays the MIDI files continuously
= Choose MIDI Files opens the Choose MIDI Files dialog box in which you can choose MIDI or
RMI files
Up moves the selected file up the list

3 Down moves the selected file down the list
3 Remove deletes the selected file from the list
Related topics

3 Slide Show dialog box
= Creating a slide show



Choose MIDI Files

= File Name initially shows the MID and RMI extension; if you know the path and name of the file
EIU wish to load, enter it here or select it from the list box

List Files of Type shows the available file formats and their extensions. You can use wildcards
%I*) to display all files in the directory

Directories shows the current path and any subdirectories under that path
= Drives lists all the available drives
= Browse opens the Browse dialog box, use this dialog box to search for MIDI or RMI files
= Network allows you to connect to a network (only available if you are running Windows for
Workgroups)

Related topics

= Background Music
= Creating a slide show



Load Slide Show

= File Name initially shows the SHW extension; if you know the path and name of the file you wish
to load, enter it here or select it from the list box

List Files of Type shows the file extension for slide shows (SHW).You can use wildcards (*.*) to
display all files in the directory

Directories shows the current path and any subdirectories under that path

Drives lists all the available drives
= Browse opens the Browse dialog box; use this dialog box to search for keyword files
= Network allows you to connect to a network (only available if you are running Windows for
Workgroups)

Related topic
= Slide Show dialog box



Save Slide Show

= File Name allows you to enter a filename or, if you wish to overwrite an existing file, select its
filename from the files list box

List Files of Type shows the file extension for slide shows (SHW). You can use wildcards (*.*) to
display all files in the directory

Directories shows the current path and any subdirectories under that path

Drives lists all the available drives
= Browse opens the Browse dialog box; use this dialog box to search for files
= Network allows you to connect to a network (only available if you are running Windows for
Workgroups)

Related topic
= Slide Show dialog box



Slide Show Controls

When you select the Manually with Keyboard or Mouse option in the Slide Show dialog box and click
OK, the Slide Show Controls dialog box appears. This dialog box displays a list of available keyboard
commands with which you can control the slide show.

Click OK to start the slide show.

Note: This dialog box appears only once in a session. To access it again exit and reopen Album.

Related topics

= Slide Show dialog box
=l Creating a slide show



New Group

Program Group:
Group Name allows you to enter a name for the new program group
Program Icon:
Description allows you to enter a description to identify the application to be inserted in the
toolbox (this is optional; if you do not enter a description, Album will automatically add it for you)
Command Line allows you to enter the path and extension of the application
= Working Directory allows you to enter the directory in which the program files are found
= New adds the new program group or program item into the toolbox (only available if you have
entered a group name or the command line of an application)
Browse opens the Browse dialog box, use this dialog box to search for program files

Related topic
3 Adding a program



Delete

= Delete Current Program Group shows the name of the current program group you can delete
= Delete Program Icon From Current Group allows you to choose the program item you wish to
delete

Related topic
= Removing a program



Toolbox Properties

= Group Name displays the name of the current program group
= Program Icon lists all the program items present in the current group
E3 Description shows the description of the selected program
= Command Line displays the path and extension of the selected program and the command line
options
Working Directory shows the directory which the program files use as default directory

= Browse opens the Browse dialog box, use this dialog box to search for files

Related topic

3 Changing the properties of a program



Configure

= Position allows you change the location of the toolbox
= Show Names when selected displays the program names below the icons
= Icons to Show allows you to specify the number of programs currently displayed in the toolbox.

The arrow key is used to display hidden program icons in the group

Related topic
= Configuring the programs



Run
= Command Line allows you to enter the path and extension of the program you wish to run
= Run Minimized when selected minimizes the program immediately after opening a program
= Browse opens the Browse dialog box, use this dialog box to search for files




Insert

= File Name initially shows the selected extension; if you know the path and name of the file you
wish to insert, enter it here or select it from the list box

List Media Types allows you to select a particular media type
= List File Types of Media Type shows all the file extension of the selected media type. You can
use All Formats to display all files with the available file formats

Directories shows the current path and any subdirectories under that path

= Drives lists all the available drives
= Insert Files to Album allows you to select an album in the workspace into which files will be
inserted
= Options accesses the open options dialog box for file formats that provide options
Info opens a dialog box displaying information about a file selected in the files list box
= Browse opens the Browse dialog box, use this dialog box to search for files
= Network allows you to connect to a network (only available if you are running Windows for
Workgroups)

Include all Subdirectories when selected allows you to collect thumbnails from all files in the
current directory and all its subdirectories. Deselect this to only collect thumbnails from the files in the
current directory

Write Errors and Journals to File collects any errors that may have occurred when collecting
thumbnails, into the Journal.txt file in your local Windows directory

Related topics

= New dialog box
= File formats

= Inserting files



Copy Files

= Copy Files to Directory allows you to enter the target path and directory to which files will be
copied

Drives lists all the available drives
= Insert Copied Files to Album inserts the copied files' thumbnail into an album in the workspace

Information displays information on the size of the original file(s) and the disk space available on
the selected drive

Browse opens the Browse dialog box; use this dialog box to search for files
= Network allows you to connect to a network (only available if you are running Windows for
Workgroups)

Related topic
3 Copying files



Move Files
= Move Files to Directory allows you to enter the target path and directory to which source files
will be moved
Drives lists all the available drives

= Information displays information on the size of the original file(s) and the disk space available on
the selected drive

Browse opens the Browse dialog box, use this dialog box to search for files

= Network allows you to connect to a network (only available if you are running Windows for
Workgroups)

Related topic
= Moving files



Rename Files
= From shows the selected filename and extension
= To allows you to rename the selected thumbnail file

Note: You cannot rename files to a different file extension. You can rename a group of files only with the
same extension but having different file names.

Related topic
= Renaming files



Attributes
= File Attributes changes the attributes of selected files

= Date and Time shows when a file was last changed. If you have more than one file selected, no
information will be shown
= Information displays the number of files selected and the disk space occupied

Related topic

= Changing file attributes



Associate

= Files With Extensions shows the file extension of the file you have selected

= Associate With Program allows you to choose the application to associate with

= Browse opens the Browse dialog box, use this dialog box to search for files
Related topic

3 Changing file association



= Title allows you to give a title to the new album (up to 23 characters)

= Size allows you to change the size of the thumbnails the album will contain

= Compression allows you to change the thumbnails' compression scheme

= Display Thumbnails in Grayscale allows you to display thumbnails in the album as gray

images. This option is only available when you are using a 16-Color display and you have selected
"Bypass VGA palette to enable use of 16 grays" in the VGA Palette dialog box (accessed from the
Preferences: Display dialog box)
= Create Album File in Directory allows you to specify the directory and path in which the new
album is created

Description allows you to enter a description to easily identify the new album. (this is optional
and can be left blank)

= Continue to Insert Files opens the Insert dialog box after creating an album
= Keywords opens the Keywords dialog box in which you can assign keywords to an album
Related topic

= Creating a new album



Open
= File Name initially shows the ABM extension; if you know the path and name of the album you
wish to open, enter it here or select it from the list box

Note: Entering the first or beginning sequence of characters for a filename automatically scrolls the
list box close to that file
List Files of Type shows the file extension for albums (ABM). You can use wildcards (*.*) to
display all files in the directory
Directories shows the current path and any subdirectories under that path

= Drives lists all the available drives

= Info opens a dialog box displaying information about the album selected in the filename list box
= Browse opens the Browse dialog box; use this dialog box to search for files

= Network allows you to connect to a network (only available if you are running Windows for
Workgroups)

Read Only prevents any changes to be made to the album. Checking this option will disable
some commands

Related topic
3 Opening an album



Convert File Format

= Convert Image/Graphics Files to specifies the format to convert to
= Save Converted Files in specifies where to save the converted files: in the same subdirectory as
the originals or in a new directory

Delete Files and Remove From Album deletes the original files from disk and their thumbnails
from Album

Insert Converted Files to Album allows you to insert the converted files into an album in the
workspace
= Options opens the save options dialog boxes for file formats that provide options

Browse opens the Browse dialog box; use this dialog box to search for files

Note: Some file formats may not support the data type of the source file. In such cases, a warning
message will be displayed.

Related topics

=l Supported file formats
3 Converting between file formats



Convert Data Type

= Convert Image/Graphics Files to specifies the data type to convert to
= Overwrite Original Files replaces the original file with the new data type
= Create New Files in Subdirectory allows you to place the converted file in a specified directory

Insert Converted Files to Album allows you to insert the converted files into an album in the
workspace
Browse opens the Browse dialog box, use this dialog box to search for files

Note:Some file formats may not support the data type of the source file. In such cases, a warning
message will be displayed.

Related topic
= Converting between data types



Batch Manager

= Operation allows you to choose the command that can be applied to multiple albums
= Albums allows you to choose the albums to which the operation will be applied

E3 Select All selects all the albums in the workspace

= Deselect deselects any selected albums

Related topics

Save Sequence
Check

Remove
Windows Control Menu
Print Thumbnails

Shelf dialog box

Sort Files dialog box
View Menu

Search dialog box

Using the Batch Manager
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Sort Files

= Sort By sorts the files by the selected option
= Image Width opens the Sort dialog box in which you can sort the files by the selected media type
and its attribute

Related topic
= Batch Manager dialog box



Acquire
= File Name initially shows the selected file extension, if you know the path and name of the file,
enter it here or select it from the list box
List Files of Type shows the available file formats and their extensions
Directories shows the current path and any subdirectories under that path
Drives lists all the available drives
Options opens the save options dialog boxes for file formats that provide options
Browse opens the Browse dialog box, use this dialog box to search for files
Network allows you to connect to a network (only available if you are running Windows for
Workgroups)
Increase File Number by Two allows you to automatically save scanned images to filenames
which are numbered in increments of two
= Image Data Type Supported shows the data type supported by the selected file format
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Print Album

= Number of Copies defines the number of copies of the album you wish to print

= Print allows you to choose text information to be included in the printout

= Thumbnail Size allows you to define the size of the thumbnails

= Print Selected Items Only prints only the selected thumbnails of an album

= Create Thumbnails From Original File reads the original image or graphics files to be

resampled to thumbnails
Printer shows the currently selected printer (selected in the Printer Setup dialog box)
= Page opens the Page Setup dialog box in which you can define the setup of the output page

Related topic
= Printing an album



Page Setup

= Margins allows you to define the margins of the output page
= Header and Footer allow you to enter text that will appear on the output pages
E3 Append allows you to enter specific information items into the Header and Footer texts

Fonts opens the Fonts dialog box in which you can set the typeface of the output pages

Related topics

= Print Album dialog box

= Print Thumbnails dialog box
3 Print Keywords dialog box
= Print dialog box



Fonts

= Font lists all the typefaces you have installed

= Size allows you to set the size of the selected font

= Sample lets you preview the typeface in the selected font size
Related topics

3 Page Setup dialog box
= Album dialog box



Fonts

= Font lists all the typefaces you have installed
= Font Style allows you to choose a style for the selected font
= Size allows you to set the size of the selected font

Sample lets you preview the typeface in the selected font style and font size

Related topics

= Slide Show Text dialog box
= Album dialog box



Print Thumbnails

= Number of Copies allows you to enter the number of copies to print
= Print allows you to choose File Name, Index Number and Thumbnail Slide to be included in the

rintout
% Number of Thumbnails per Page allows you to set the number of rows and columns. The
maximum number of rows and columns are determined by the thumbnail size you select
Thumbnail Size allows you to define the size of the thumbnail

= Print Selected Items Only prints only the selected thumbnails of an album

= Create Thumbnails From Original File reads the original image and graphics files to be
resampled to thumbnails

= Printer shows the currently selected printer (selected in the Printer Setup dialog box)

= Page opens the Page Setup dialog box in which you can define the setup of the output page




Print Keywords

= Number of Copies allows you to enter the number of copies you want to print
= Keywords to Print allows you to select the keywords you wish to print with additional information
such as filenames and index numbers with same keywords

Printer shows the currently selected printer (selected in the Printer Setup dialog box)

Page opens the Page Setup dialog box in which you can define the setup of the output page




Album

Display Information
Thumbnail Mode displays filenames or subjects under their thumbnails
= Filename Mode displays file attributes, keywords, subject, description or directory when in
filename mode
Don't Show Thumbnail Slide displays the thumbnail without the frame in the thumbnail mode

= Reduce True Color to 256-Colors enables the conversion of True Color thumbnails to 256-
Color. This reduces the size of the album's file size by two-third if most of the images are True Color
= Enable Automatic Checking of Source Files automatically updates files which have been

changed or, if file is missing, crosses the index number

Minimize on Use minimizes Album when you open another application from Album
= Sort Thumbnails in Ascending Order causes thumbnails to be displayed in normal
alphanumeric order

Swap Out to Disk When Minimized when selected speed up the operations in Album by
conserving memory

Fonts opens the Fonts dialog box in which you can set the typeface used in an album




OLE & Clipboard

Formats to Copy to Clipboard places the following data formats to the clipboard for OLE operations
OLE Embedding Format copies only the necessary data formats to perform embedding
= OLE Linking Format copies only the necessary data formats to perform linking
= Device Independent Bitmap (DIB) when selected places a device independent bitmap. Use this
format as default without "Convert to Display" selected
Device Dependent Bitmap (DDB) when selected places a device dependent bitmap. Select this
format when working with old Windows applications.

OLE Representation Format determines how objects are represented in the client document
Source Object is used when the content and dimensions of the object are essential
= Low Resolution Place Holder is used when you wish to retain the original file's dimensions and
reserve disk space
Thumbnail Only places a thumbnail with the current display information set in the Album dialog
box

= Album's Program Icon places the Album icon to represent the data copied from the clipboard

Drag and Drop Operation defines the action when you drag-and-drop to a compatible application
Simulate Clipboard Copy/Paste Behavior is the same as using the copy and paste command
from the Edit menu
Paste Embedded Object Into Client embeds an object by dragging and dropping to the client
application
Paste Linked Object Into Client links an object by dragging and dropping it to the client
application

Simulate File Manager's Behavior is the same as dragging and dropping from File Manager
into another program

Related topic
= Object Linking and Embedding



Display
= View Images With a Common Palette displays all images on a 256-Color display using the
|%_Istem palette
Don't Care About Background Quality causes only the active image to be displayed as best as

ossible
% Monitor Gamma determines the amount the display of images is adjusted to accommodate for
differences in working environments
VGA Palette enables you to adjust the display of images on 16-Color displays

Related topic
= Calibrating your display



VGA Palette

= Bypass VGA Palette to Enable Use of 16 Grays causes grayscale images to be displayed with
16 grays and makes the Display Thumbnails in Grayscale option (in the New dialog box from the Album
menu) available

Compatibility Test tests to see if your display card is compatible with this feature

Related topic
= Display dialog box



Keywords

= Total Keywords shows the total number of keywords assigned to the active album
= New Keyword allows you to add new keywords to your current keyword list; enter a new keyword
in the text box and press the Add button or Enter

Adopt Keywords From Album includes keywords from the specified album. A message will
appear in which you can choose whether or not to retain your old keywords

Load opens the Load Keywords dialog box in which you can load an existing keywords list

= Save opens the Save Keywords dialog box in which you can save a keywords list to a file
= Add adds a new keyword to the keywords list. This command is available when you enter a new
keyword or edit an existing one
= Change replaces a selected keyword with the new one
= Remove deletes a selected keyword from the keywords list
= Remove All deletes all the keywords from the keywords list
Related topic

3 New dialog box
= Defining keywords



Load Keywords

= File Name initially shows the TXT extension; if you know the path and name of the file you wish
to load, enter it here or select it from the list box

List Files of Type shows the file extension for Windows and DOS Text (TXT) files. You can use
wildcards (*.*) to display all files in the directory

Directories shows the current path and any subdirectories under that path

Drives lists all the available drives
= Browse opens the Browse dialog box, use this dialog box to search for files
= Network allows you to connect to a network (only available if you are running Windows for
Workgroups)

Related topic
= Keyword dialog box



Save Keywords

= File Name allows you to enter a filename or, if you wish to overwrite an existing file, select its
filename from the files list box

List Files of Type shows the file extension for Windows and DOS Text (TXT) file. You can use
wildcards (*.*) to display all files in the directory

Directories shows the current path and any subdirectories under that path

Drives lists all the available drives
= Browse opens the Browse dialog box, use this dialog box to search for files
= Network allows you to connect to a network (only available if you are running Windows for
Workgroups)

Related topic
= Keywords dialog box



Select Source

= Sources displays all the available TWAIN sources; select a source to make it the active TWAIN
driver in Windows




Move Album

= Move Album to Directory allows you to enter the target path and directory to which the active
album files will be moved
Drives lists all the available drives

= Browse opens the Browse dialog box, use this dialog box to search for files
= Network allows you to connect to a network (only available if you are running Windows for
Workgroups)

Information at the bottom of the dialog box displays information on the size of the active
album/mark file and the disk space available on the selected drive




Copy Album

= Copy Album to Directory copies the active album file to another directory
Drives lists all the available drives
= Browse opens the Browse dialog box, use this dialog box to search for files
= Network allows you to connect to a network (only available if you are running Windows for
Workgroups)

Information at the bottom of the dialog box displays information on the size of the active
album/mark file and the disk space available on the selected drive




Rename Album File

= Original Album Filename displays the path and directory of the active album
= New Album Filename allows you to enter a new filename for the album




Backup

= Backup Album to Directory allows you to enter the target path and directory in which the album
will be backed up. All the original files in that directory will be removed first

Drives lists all the available drives
= Backup Selected Files Only backs up the files of selected thumbnails only

Compress Files compresses the files with a lossless LZW scheme that compresses files by 15%
to 40% as they are backed up and consequently slows down the whole process

Browse opens the Browse dialog box, use this dialog box to search for files
= Network allows you to connect to a network (only available if you are running Windows for
Workgroups)

Information at the bottom of the dialog box displays the total size of files to be backed up and the
total disk space available on the selected drive

Related topic
= Backing up an album



Restore

= Restore Album From Directory allows you to enter the source path and directory from which the
album will be restored
Drives lists all the available drives

= Info opens a dialog box displaying information about the backed up album in the files list box
Browse opens the Browse dialog box, use this dialog box to search for files
= Network allows you to connect to a network (only available if you are running Windows for
Workgroups)
Restore to allows you to restore files to their original subdirectory or to another subdirectory
= Information at the bottom of the dialog box displays the number of files to be restored and the

disk space required

Related topic
= Restoring an album file



Scroll To

= Scroll To allows you to go to a particular thumbnail instead of scrolling through a huge album.
Specify the thumbnail's index number or enter the filename directly in this text box




Auto Scroll
= Delay Time allows you to set the time (in seconds) between each scroll




Search by Keywords

= Query allows you to define single or multiple keywords for the search condition
= Keywords allow you to select a keyword from the list box
= Operators are used to specify multiple keywords in the query text box




Search by Subjects

= Query allows you to define single or multiple subjects for the search condition

= Match Case distinguishes lowercase and uppercase letters and treats the word apples totally
different from Apples or APPLES

= Match Whole Word searches for the word as a whole and not when it is embedded in another
word

= Operators are used to specify multiple subjects




Search by Marks

= Query allows you to define single or multiple marks for the search condition
= Marks lists all the available marks
= Operators are used to specify multiple marks in the query text box




Search

= Search Criteria allows you to select and edit the conditions for a search criteria in the list box
= Add adds a search condition into the list box below
= Change changes a selected condition in the list box below
Remove deletes a selected search condition in the list box below
= Search All Albums in the Workspace searches for thumbnails with the specified criteria in all

the albums in the workspace

Action to Take allows you to view, select or go to thumbnails. The Go To action displays the Go
to Thumbnail dialog box
= Query allows you to enter a query name for a search criteria you have defined. Press Enter to
include the query in the list box.

Remove deletes a selected query from the list box

Related topics

Search by Keywords dialog box
Search by Marks dialog box
Batch Manager dialog box
Defining search criteria
Searching for thumbnails

[ o] [ ] [



Go to Thumbnail

= Thumbnails found lists the number of thumbnails matching the search criteria
= Album shows the title of the album to which the thumbnail belongs
= Goto button displays the selected thumbnail indicated by a yellow pointer

Related topic

3 Search dialog box
= Creating a slide show



More Queries
3 Queries lists all the predefined queries with its search conditions in the list box

Related topic
= Defining search criteria



Sort

= Media Types of Files lists all the available media types
= Sort Files By allows you to select the attribute by which you can sort the selected thumbnails




Edit Marks

= Mark Name allows you to define a new mark name or edit an existing mark name
= Marks allows you to select from a list of 26 marks (shown by letters A to Z) for editing
E3 Adopt Marks From Album uses the marks from an album in the workspace

Clear All removes all the defined mark names

Related topic
= Mark Palette Control Menu
= Editing marks



Load Marks

= File Name initially shows the MRK extension; if you know the path and name of the file you wish
to load, enter it here or select it from the list box

List Files of Type shows the file extension for marks (MRK). You can use wildcards (*.*) to
display all files in the directory

Directories shows the current path and any subdirectories under that path

Drives lists all the available drives
= Merge With Original Marks merges the marks loaded from a file with the marks defined in your
active album

Replace Original Marks replaces the marks of your active album with the marks previously
saved to a file
= Browse opens the Browse dialog box, use this dialog box to search for files
= Network allows you to connect to a network (only available if you are running Windows for
Workgroups)

Related topic
3 Mark Palette Control Menu
3 Loading and saving marks



Save Marks

= File Name allows you to enter a filename or, if you wish to overwrite an existing file, select its
filename from the files list box

List Files of Type shows the file extension for marks (MRK). You can use wildcards (*.*) to
display all files in the directory

Directories shows the current path and any subdirectories under that path

Drives lists all the available drives
= Browse opens the Browse dialog box, use this dialog box to search for files
= Network allows you to connect to a network (only available if you are running Windows for
Workgroups)

Related topic
= Mark Palette Control Menu
= Loading and saving marks



Convert to Keywords

= Clear Marks From Selected Thumbnails allows you to remove the selected mark(s) from the
%ecified thumbnails after converting marks into keywords

Clear Mark Names From Palette allows you to delete the mark(s) from the mark palette after
converting marks into keywords
Note: You must first select some thumbnails with assigned marks and choose some mark(s) in the mark
palette before conversion.

Related topic
= Mark Palette Control Menu
3 Converting marks to keywords



More Groups
= Groups lists all the program groups you have assigned




Browse



cgm



dxf



pcd



pic



bmp



eps



iff



jpeg



psd



ras



tga



tif



Remove

Removes an album from the workspace but the album remains on disk and can be reopened with the
Open command.




Printer Setup

Please see your Windows documentation or Windows on-line Help for more information about this
command.




Properties

Allows you to edit an album's properties such as its title, thumbnail size, compression scheme,
description, and its read-only attribute.

Related topic
3 Album Properties dialog box



Keywords

Allows you to assign keywords to an album which is used as an index to search for thumbnails. Each
album has its own keyword list which is limited to 64KB of memory.

Related topic
3 Keywords dialog box



Acquire

Displays the Acquire dialog box which varies according to the image input device you have installed.

If you select this command and you do not have a TWAIN device installed nothing will happen. If you do
have a TWAIN device but it is incorrectly installed, a dialog box appears containing installation options.

Related topic
Acquire dialog box



Select Source

Allows you to select the TWAIN device you wish to use.

Related topic
3 Select Source dialog box



Maintenance: Check

Checks and updates files contained in the active album.

After selecting the Check command, the active album's thumbnails are checked against the source files.
Any necessary updating is done automatically. If a file cannot be found on disk, you can choose to
delete its thumbnail from the album or skip checking that thumbnail.




Maintenance: Move

Moves the active album files from the current directory to the target directory. Although the files are
moved to another directory the album is still retained in the workspace.

Related topic
= Move Album dialog box



Maintenance: Copy

Makes a copy of the active album file from the current directory to the target directory. The copied
album file has the same title as the original album but is numbered consecutively.

Related topic
3 Copy Album dialog box



Maintenance: Delete

Deletes an album file from disk and removes it from the workspace. Once deleted, the album file cannot
be recovered unless you have a backup.




Maintenance: Rename
Renames the album file but the title of the album remains the same.

Related topic
3 Rename Album File dialog box



Preferences: Album

Allows you to customize certain features of Album. The options increase the flexibility and ease of use
as you work.

Related topic
= Album dialog box



Preferences: OLE & Clipboard

Allows you to select which formats will be copied to the clipboard when embedding or linking. Choose
the appropriate formats to save time and disk space. You also have the options to choose the
representation format and the drag-and-drop operation.

Related topic
3 OLE & Clipboard dialog box



Preferences: Photo CD

Allows you to set the options for an image in PCD format (developed by Kodak for its Photo CD
products and supports Grayscale, Indexed 256-Color, and RGB True Color images).

Related topic
= Photo CD dialog box



Preferences: Display

Allows you to customize the display of images. Many of the options are specific to different display
environments; whether these options are available or not depends on your particular environment.

Related topic
= Display dialog box



Preferences: Memory

Allows you to allocate additional working space. Use this to specify working directories to be used when
there is insufficient space in your TEMP directory.

Related topic
= Memory dialog box



Preferences: File Formats

Allows you to choose the file formats you want to use. You may want to choose only the file formats you
use frequently.

Related topic
3 File Formats dialog box



Print: Album

Allows you to print thumbnails in an album with the option to print accompanying text information. The
printout generated from this command gives you a summary of the thumbnails in your album.

Related topics

3 Print Album dialog box
= Printing an album



Print: Thumbnails
Allows you to print thumbnails contained in an album, with or without accompanying filenames, index
numbers or thumbnail frames. This printout can serve as a record for future use and is especially useful

for archived albums.

Related topic
3 Print Thumbnails dialog box



Print: Keywords

Allows you to print a list of keywords together with flenames and their index numbers which have been
assigned the same keywords.

Related topic
3 Print Keyword dialog box



Print: File
Allows you to print the files of selected thumbnails from an album.

If you select image files, the Print dialog box appears; printing of application-linked files is controlled by
their linked application.

Related topic
= Print dialog box



Undo

Reverses the effect of the last applied command (if possible).




Repeat

Repeats the effect of the last applied command.




Cut

Removes selected thumbnails from an album and transfers them onto the clipboard.




Clear
Deletes selected thumbnails from the album.




Paste

Places thumbnails from the clipboard into an album.
This command is available only if the clipboard contents were previously cut or copied from Album.




Make Album

Duplicates the active album with only the selected thumbnails. The new album will have the same title
but is numbered consecutively.




Run

Runs the application associated with the file. Use the Associate command in the File menu to change
the association.




Copy: File

Copies the contents of selected thumbnails' files (either image or graphics) onto the clipboard.




Copy: Thumbnail

Copies the selected thumbnails onto the clipboard.

Related topic
Copying thumbnails



Copy: Filename

Copies the full path and filename of selected thumbnails' files.




Select: All

Selects all the thumbnails in the active album.




Select: None

Deselects any selected thumbnails in the active album. Clicking on the album's status bar also
deselects all thumbnails.




Select: Invert

Selects the thumbnails which are not currently selected.

If you have five thumbnails in an album and one is selected, apply this command to deselect the
selected thumbnails and select the others.




Search by Keywords

Searches for files by their keywords assigned in the Thumbnail Properties dialog box.

Related topics

Search by Keywords dialog box
Searching for thumbnails



Search by Subjects

Searches for files by their subjects assigned in the Thumbnail Properties dialog box.

Related topics

Search by Subjects dialog box
Searching for thumbnails



Search by Marks

Searches for files by their marks assigned in the Mark Palette.

Related topics

Search by Marks dialog box
Searching for thumbnails



List of defined queries

Shows the queries you have defined in the Search dialog box. Queries are predefined search criteria
you can use later to search for thumbnails. If you have more than nine queries, use the More command

to display the rest.

Related topics
More Queries dialog box
Search dialog box
= Defining Queries



Search Entire Album
Searches on all thumbnails within an album.




Sort by Name

Sorts all files in the active album alphabetically by their flenames, according to the order set in the
Preferences: Album dialog box.




Sort by File Type

Sorts all files in the active album alphabetically by their file extension, according to the order set in the
Preferences: Album dialog box.




Sort by Size

Sorts all files in the active album by their sizes, according to the order set in the Preferences: Album
dialog box.




Sort by Date

Sorts all files in the active album by the date they were last modified, according to the order set in the
Preferences: Album dialog box.




Sort by Media Type

Sorts all files in the active album by the media type, according to the order set in the Preferences:
Album dialog box.




Sort by Subject

Sorts all files in the active album by their subjects (only if subjects are assigned), according to the order
set in the Preferences: Album dialog box. If you have not assigned any subjects, sorting does not take
place.




Sort by Description

Sorts all files in the active album by their description (only if descriptions are assigned), according to the
order set in the Preferences: Album dialog box. No sorting will take place unless you have assigned
some description to files.




Sort by Others

Sorts all files in the active album by the selected media type and their attributes.

Related topic
= Sort dialog box



User Defined

Sorts files by a user defined sequence.




Move

Changes the location of selected thumbnails in an album.

Related topic
= Move dialog box



Save Sequence
Makes the current order of files in an album the new user-defined order.




Update: From File

Restores a thumbnail after it was replaced with the From Clipboard command.




View: All

Displays all the thumbnails or flenames in an album.




View: Invert

Displays the thumbnails or filenames other than the ones displayed after a search.




View: Selected

Displays only the selected thumbnails or filenames in an album.




Scroll To

Allows you to quickly scroll to a particular thumbnail specified in the Scroll To dialog box.

Related topic
= Scroll To dialog box



Auto Scroll

Automatically scrolls the thumbnails in an album in the specified time.

Related topic
3 Auto Scroll dialog box



Thumbnails

Display the thumbnails of files contained in an album.




Filenames

Display the filenames of files in an album along with other information.
Scroll with the arrow buttons at the bottom of the status bar to view the rest of the displayed information.




Slide Show

Displays selected files from the active album in a slide show with a choice of 18 transition effects. If no
files are selected, the slide show will display all thumbnails in the active album. If the album contains
application-linked files and MIDI files they are skipped in the slide show.

Related topic
3 Slide Show dialog box



Album Information

Displays a dialog box containing information about the active album.




File Information

Displays a dialog box containing information about a selected thumbnail file.




Associate

Allows you to associate a file to a program so that you can directly run the file in that program by just
double-clicking on the file's thumbnail.

Related topics

= Associate dialog box
= Changing file association



Attributes

Allows you to change the file attributes such as read only, hidden, system and archive.

Related topics

= Attributes dialog box
= Changing file attributes



Delete
Removes files of selected thumbnails from disk (and deletes the thumbnails from their album).

To delete thumbnails and their files, choose "Delete" from the File menu. We recommend you to back
up files before deleting them. Once a file is deleted, Album has no way of recovering it unless you have
backed it up.




Hide/Show Toolbox

Hides or shows the toolbox. This command is also available in the status bar button.

Related topics
= Toolbox
= Customizing the toolbox



Hide/Show Mark Palette

Hides or shows the Mark palette. This command is also available in the status bar button.

Related topics
= Mark Palette
= Using the Mark Palette



Hide/Show Search Ribbon

Hides or shows the Search Ribbon. This command is also available in the status bar button.

Related topic
3 Using the Search Ribbon



Always on Top

Ensures that Album is never covered by any other open windows on your desktop. This command is
particularly useful if you want to drag-and-drop files between Album and other applications.




Cascade

Stacks open windows so that the title bars are visible.




Tile

Resizes all open windows to the same size and arranges them to fill the workspace.




Arrange Icons

Arranges all minimized icons along the bottom of the workspace.




Windows List

Contains the titles of all albums currently in the workspace.




Contents
Starts Help and displays the topics in the Album Help.




Search for Help on

Opens the Search dialog box containing keywords from the Help topics.




How to Use Help

Accesses the Windows guide to using Microsoft Help.




About Album

Displays the Album product information box.




About Ulead Products

Displays information about other Ulead products.




Update

This command is only available when you embed an object from Album into a client application's
document. Double-click on the embedded object (in the client application); the thumbnail is displayed in
the Viewer program. You can run Image Editor (or any other editor) if you wish to edit it. If you edit the
thumbnail's file or select another thumbnail, use the Update command to update the embedded object.




If you specify a directory that does not exist, it is created by Album.



Filenames can be entered with or without a file extension and automatically numbered in consecutive
numbers. If no extension is entered, the extension selected in the List Files of Type list box is
automatically added.



Text which appears at the top (Header) and/or at the bottom (Footer) of the page. Use the Append list
box to insert special item codes.



This list box is available when the text cursor is in either the Header or Footer text box. Select an item
to insert the appropriate code.

Of all the Append options, only one requires further explanation, the Separator. Insert one separator to
make the text following the separator, align on the center of the page. Insert a second one to align text
to the right of the page. Additional separators are ignored.



These text boxes allow you to specify the amount of space between the edges of the paper and the
position of the outer thumbnails. Headers and footers are displayed within this area.



The current unit of measure is taken from your current Windows measurement system defined with the
International option under Windows Control Panel.



Selecting the Don't Show option hides the filenames and enables you to see more thumbnails in an
album at any one time.



Ascending order is in normal alphanumeric order, with numerals preceding letters. This option does not
have any effect on the user defined arrangement.



You can select multiple filenames by clicking and dragging down the list or using the SHIFT and/or
CTRL key in conjunction with the mouse.



You can specify multiple conditions by using the Boolean (or logical) operators, AND, OR, and NOT and
separating conditions.

NOT is used to perform Boolean (or logical) negation. For example, specify "map" (map could be used

in keywords, subjects, marks or any other search condition) and double-click on the NOT operator.
Album selects all files that are not "map".



You can choose from 18 search criteria. The search criteria group box changes according to the search
criteria you choose.



Initially displays the existing description of a selected thumbnail that you can edit or, if the text box is
empty it means that either the selected thumbnail has no description or you have selected multiple
thumbnails to which you can apply the same description.



The time specified does not include the time it takes to read or display images. For large images this
means the time between slides may be considerably longer than the specified amount.



Each thumbnail is checked against its source file. Any necessary updating is done automatically. If a file
cannot be found on disk, a message box appears asking if you want to delete it from the album.



To move thumbnails, choose "Cut" from the Edit menu to remove them from one album and then, after
making another album active, choose "Paste" to place them in the second album, or simply drag-and-
drop the thumbnails to another album (press the CTRL key down if you want to copy the thumbnails).



To add files to an album, drag them from Windows File Manager, CD Browser or Viewer, and drop them
into an album in the workspace.



To move thumbnails onto the clipboard, select them in an album and then choose "Cut" from the Edit
menu. The selected thumbnails can then be pasted into another album using the Paste command.



Select the thumbnails you want to delete from the album and then choose "Clear" from the Edit menu.
Selected images are deleted from the album but not from disk, which means you can still reinsert them
to the same or another album.



Choose one of the commands from the Sort submenu in the Thumbnail menu. The available sort
commands are: Name, File Type, Size, Date, Media Type, Subject, Description, Others, and User
Defined.



Choose "Save Sequence" from the Thumbnail menu. After using the Save Sequence command, the
current order of thumbnails in the album becomes its user-defined order.



The scroll buttons are available whenever the toolbox contains more program icons than it can display at
one time. Clicking on the scroll buttons displays more tools.



Clicking on an icon in the toolbox invokes and transfers control to that program. Dragging thumbnails and
dropping them onto an icon, opens the chosen program with the selected thumbnails' files (only if it
supports the file formats and open multiple files).



If you redefine the thumbnail size, thumbnails are regenerated from their original files or linked
applications. If the original file or linked application of a thumbnail cannot be found, it is regenerated
from the existing thumbnail.

Eleven sizes are available from 32x32 to 192x192. The files of albums with larger thumbnails will be
slightly larger on disk but give you better representation of images and graphics. Application-linked files
icons are always 32x32, so for these, the smallest size allows you to display more thumbnails at one
time without reducing the visual impact of each.



Eleven sizes are available from 32x32 to 192x192. The files of albums with larger thumbnails will be
slightly larger on disk but give you better representation of images and graphics. Application-linked files'
icons are always 32x32, so for these, the smallest size allows you to display more thumbnails at one
time without reducing the visual impact of each.



The Batch Manager allows you to apply the following operations to multiple albums at the same time:
Check, Minimize, Print Thumbnails, Put on Shelf, Remove, Restore, Save Sequence, Search, Sort by,
View All, View Thumbnails, and View Filenames.



Within this list box, you can select multiple files by dragging down the list and by using the SHIFT and
CTRL keys in conjunction with the mouse.



Before you select this option you should test your display card to see if it is compatible with the
Compatibility test provided.



When you press this button, the color squares on the right become squares of different grays, if your
card is compatible. If your card is incompatible, nothing will happen or you will have to restart your
computer.



This option is available if you are using a 256-Color display. This is an important option if you want to
view Grayscale images at the same time as color images on a 256-Color display, or compare any sort
of image on a 256-Color display.



This affects the speed of display updating on 256-Color displays. When selected, Album only updates
the active image. Images in the background may appear distorted, blurred, or grayed. The content of
the background images is not changed, only the way they are displayed. If you wish to compare two or
more images, deselect this option.



Use this feature to display images correctly on all types of computer display. When this option is
disabled, or set to 1.00, the display of images is not adjusted.



JPEG compression offers high compression in the ratio of 100:1 (original file: compressed file) and is
recommended when disk space is at a premium or when you have large files. This compression
scheme may degrade the quality of images as some data is discarded but will speed up access to the
files.

Lossless compression compresses files by 15% to 40% and files are restored to their original state but
access to the files is much slower.

JPEG compression can only be applied to True Color and Grayscale images while lossless
compression can compress all thumbnails using the LZW compression.



Although the file is moved to another directory the album is still retained in the workspace.



Assign keywords to a thumbnail by selecting a keyword from the Keywords List below and pressing
Enter. The keyword is added in the list box above it. You can assign up to 32 keywords to each
thumbnail.

A keywords List exists only if you have assigned keywords to an album in the Keywords dialog box or,
by typing a new keyword (up to 31 characters) and pressing Enter. The number of keywords in an
album is limited to 64KB of memory.

To remove a specified keyword assigned to a thumbnail, press the Remove button.



If you are not sure of the directory use the Browse button to search for files.



The attributes give you information about the file. For more information on each attribute refer to your
Windows documentation.



If you select Don't Show in thumbnail mode, the selected thumbnail is shown by a highlighted border
around it.



The floating toolbox can be positioned anywhere within the workspace. Click on the title bar and drag
the toolbox.



You can choose to display the filename, full pathname, subject, description or no text at all, during the
slide show.



Displays thumbnails with the specified marks or all the thumbnails (View All) in an album. Select one or
multiple marks (by dragging down the marks list or using the CTRL or SHIFT keys) and use the AND
and OR operators to display the thumbnails bearing the selected marks.



Assigns a selected mark to a thumbnail. After you click on the button, the pointer changes to a mark
pointer. Click on a thumbnail to assign the selected mark. Press the Stop button to stop assigning
marks.



Shows all the mark names. Each letter can be assigned a mark name (up to 31 characters) by selecting
the Edit command in the Mark Palette's control-menu or double-clicking on a mark.

Within this list box, you can select multiple files by dragging down the mark names or using the SHIFT
and CTRL keys in conjunction with the mouse.



You must first assign a name for your query and use the Add button to add it to the list box. Select a
search criteria and define multiple search conditions with the AND or OR operators to add it in the list
box below.



This is helpful when you scan images on double-sided pages in a scanner equipped with an automatic
document feeder. You can scan only one side and save them to odd numbered files and then the
reverse sides saved to even numbered files.



To facilitate transferring and sharing of data between different programs, the server program places
more than one data format to the clipboard. The client program chooses the data format which is most
compatible.

The OLE Embedding Format places three data formats to the clipboard: Native, OwnerLink and Picture.

Note: If the copied thumbnail is a WAV file, then an additional wave data format is placed on the
clipboard.



OLE Linking Format places two data formats to the clipboard: Picture and ObjectLink.

Note: If the copied thumbnail is a WAV file, then an additional wave data format is placed on the
clipboard.



If you frequently change your screen resolution or transfer files to another machine, you should select
this option, together with the Embedding or Linking Formats, to ensure that the files retain the same
properties in different machines.

The Convert as Display Mode option converts the data type of an image (when placed onto the
clipboard) to that of your current display mode, and is particularly useful if you are using a low resolution
display and wish to save on system resources.



Select this format if you work on a stand-alone machine, do not share data with other machines and
work in the same screen resolution. This records the minimum amount of display information necessary
when using the clipboard.



Image or graphic files display the entire file in its original resolution and dimensions, in the client
application. Wave or MIDI files are represented by the Album program icon whereas video or animation
files display the first frame of a sequence.



The selected thumbnail's file is used to generate a low resolution version to be placed in the client
application. This low resolution place holder retains the original image dimensions but has a grainy
effect. When printing the client document (specially in linked objects) change the format to "Source
Object" to print out the real content of the object.

Wave or MIDI files show the Album program icon whereas video or animation files display a low
resolution place holder of the first frame of a sequence.



Depending on the entries you make in the Paste section of the ULEAD.INI file, the embedding
command can be made available in the client program. For example, if the Paste section contains the
line Winword=Edit:Paste;Edit:Paste Special then the first command is used when you select "Paste
Embedded Object into Client".

For best results, make sure you have selected the OLE Embedding and DIB formats and the Paste
Embedded Object into Client option.



Depending on the entries you make in the Paste section of the ULEAD.INI file, the linking command can
be made available in the client program.

For example, if the Paste section contains the line Winword=Edit:Paste;Edit:Paste Special then the
second command is used for "Paste Linked Object into Client".

For best result, make sure you have selected the OLE Linking and DIB formats and the Paste Linked
Object into Client option.



If this option is selected, Album will take some time to check the source files from time to time. This may
slow down viewing and repainting of thumbnails dramatically specially in CD-ROM albums.



The total number of keywords you can define in an album is limited to 64KB of memory whereas the
maximum keywords you can assign to a single thumbnail is 32. Each keyword can contain only up to 31
characters.



In all the MediaStudio programs, the Save As dialog box allows you to add thumbnail files into an album
in the workspace. Deleting the thumbnails from the album, does not affect the source files in your
directory.



Select a search criteria from the list and type in or select a search condition in the combo box next to it.



Type in or select a search condition in this combo box.

Tip: Always use double quotation marks when you enter a subject or description to be treated as a valid
search condition.



Use this button to search and display thumbnails matching the search criteria you have defined.

Tip: Select "Search Entire Album" from the Thumbnail menu to search for thumbnails without displaying
all the thumbnails in an album.



Use this button to display all the thumbnails in an album.



Displays the following commands when you click on the button.

Shelf

Hide/Show Toolbox
Hide/Show Mark Palette
Hide/Show Search Ribbon
Search Entire Album
Always on Top
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The status bar in the Album workspace displays information about the albums on the workspace and
the shelf. If you rest your mouse pointer on an element, such as the toolbox, or press the left mouse
button and drag it on a menu command, you will see a simple explanation.



Procedures
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Album basics
Working with thumbnails

Maintaining files

Creating a slide show
Customizing the Toolbox
Search operations
Drag-and-drop operations
Object Linking and Embedding
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Album basics

Using the Batch Manager
Using Album's shelf
Creating a new album
Opening an album
Finding files on disk
Getting information
Maintaining albums
Printing an album

Exiting Album
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Maintaining albums
Checking thumbnails in an album
Changing album properties
Deleting an album
Backing up an album file
Restoring an album file
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Working with thumbnails

Placing thumbnails of files into albums
Selecting thumbnails

Viewing thumbnails

Arranging thumbnails

Copying thumbnails

Changing thumbnail properties
Relinking thumbnails and files
Changing other types of thumbnails
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Maintaining files
Converting between file formats
Converting between data types
Moving files
Copying files
Deleting files
Renaming files
Changing file attributes
Changing file association
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Search operations

Defining keywords
Using the Mark Palette
Searching for thumbnails

Defining queries




Using the Batch Manager

Use the Batch Manager command from the Album menu to apply a command to multiple albums in a
single operation. The operations can only be carried out on albums in the workspace.

1. Choose "Batch Manager" or double-click on an empty workspace to display the Batch Manager
dialog box.

2. Select an operation to be carried out from the Operation list box.

3. Select the albums you want to apply the operation to from the Albums list box. Use the Select All or
Deselect button to select/deselect all the albums.
Note: You can select multiple albums by dragging down the list or by using the SHIFT and CTRL key
in conjunction with the mouse.

4. Click OK. The operation is applied to the selected albums.

Related topics

= Batch Manager dialog box
Using Album's shelf



Creating a new album

Use the New command from the Album menu to create a new album which is saved to the disk you
specify or the default directory. The newly created album uses the first eight characters of its title as the
filename. An option to access the Insert dialog box where you can insert thumbnails of files into the new
album is also available.

—_

. Choose "New" to display the New dialog box.

2. Enter a title for the new album in the Title text box. The title you enter appears in the album's title bar.
3. Select a thumbnail size and the compression scheme to be used.

Note: JPEG compression will give you an optimized result.

Change the default directory if you want to save the new album to another directory.

Type in a short description for the new album (optional).

6. Deselect "Continue to Insert Files" if you do not want to insert thumbnails immediately after creating
the album.

7. Click OK. The new album appears in the Album workspace.

ok

Related topics

= New dialog box
=l Keywords dialog box
3 Insert dialog box



= Opening an album

Use the Open command in the Album menu to open albums from the workspace, Shelf, floppy disks,
CD-ROM disc, magnetic optic (MO) disc, network drives, or other directories on your hard disk.

1. Choose "Open" to display the Open dialog box.

2. If the album you want to open is not in the current directory, use the Directories and Drives list boxes
to locate the album.

3. Select the album you want to open from the File Name list box. If you are unsure of which album to
open, click on the Info button to display information about the selected album.
Note: Select "Read Only" if you want to only browse through the album and therefore, prevent any
changes to be made to the files.

4. Click OK. The dialog box closes and the album appears in the workspace.

Album files can also be opened by dragging them from the Windows File Manager and dropping them
into an empty area of the Album workspace. You cannot drop them on top of the status bar, toolbox, or
any open album windows or icons.

Related topic
= Open dialog box



&l Finding files on disk

There is a Browse button in all dialog boxes which involve opening or accessing files on disk. Use this
button to search for files on disk:

—_

. Click on the Browse button in the Open dialog box to display the Browse dialog box.

2. Select the drive and directory that you want to browse.

3. In the File Name text box, type the name of the file. You can use wildcards *.* to search for a group
of files with the same name or file extension, for instance, type *.JPG to search for all files with the
extension .JPG.

4. Click on the Scan button. The directory and all its subdirectories you have specified is searched.

Matching files are then listed in the Files Found box which can then be sorted in the order specified

in the Sort Files box.

Select the file you want to open from the Files Found box by clicking on it.

6. Click OK. The dialog box closes, returning you to the original dialog box and the filename and path
of the selected album are shown in the filename text box.

o

Related topic
= Browse dialog box



&l Printing an album

Use the Print: Album command from the Album menu to print thumbnails with selected information from
an album to any Windows-compatible output device. This printout gives you a summary of all the
thumbnails in your album. Select the printer with the Printer Setup command.

—_

. Choose "Print: Album" to display the Print Album dialog box.

2. Enter the number of copies you want to print in the Number of Copies text box.

3. Decide whether you want to print accompanied text information such as file attributes, keywords,
subject or description in the printout.

4. Choose the thumbnail size from the Thumbnail Size list box.

5. If you have selected "Thumbnail Image", select "Create Thumbnails From Original File" to get a good
result. However, this may be slower.

6. Click on the Page button if you wish to change the margin or header/footer.
7. Click OK. The dialog box closes and starts to print the album.

Related topic
= Print Album dialog box



Calibrating your display

Calibrate your display before you start working with images for the first time. Recalibrate whenever you
change your monitor, display adapter, or the environment in which you work.

The lighting of your work area and the brightness and contrast settings of your monitor all affect the way
images are displayed. Try to keep these variables as constant as possible to ensure that images display
consistently and accurately.

1. Choose "Preferences: Display" from the Alboum menu. The Display dialog box appears.

2. Make sure the Monitor gamma check box is unchecked.

3. Click OK to close the dialog box.

4. Choose "Insert" from the Thumbnail menu. The Insert dialog box appears.

5. Insert the file IPGAMMA.TIF. You should be able to find this file in your Pals2 directory or on the
installation disks. The IPGAMMA.TIF image appears.

6. Look at this image and identify the gray square that best matches the vertical, gray background
band. Make a note of the number displayed next to this square. If for example, the square at the
bottom of the middle row looks most like the background, take a note of the number 1.7.

This number can be any value from 0.01 to 7.99. If none of the squares exactly match, you should
estimate the best match.

7. Choose "Preferences: Display" from the Alboum menu. The Display dialog box appears.

8. Click on the Monitor gamma check box and, in the text box, type the number you noted in step 6.
Click OK and the Display dialog box closes.

Related topic

3 Display dialog box



# Changing album properties

The Properties commands in the Album menu allows you to change the title, thumbnail size,
compression scheme and description of an album. This helps you to distinguish one album from
another.

Choose "Properties" in the Album menu to display the Album Properties dialog box.
Enter an album title in the Title text box (up to 23 characters).
Choose a thumbnail size to change the size of thumbnails and the type of compression to be used.

Select "Display Thumbnails in Grayscale" to improve the clarity of thumbnails in 16-Color display
mode.

This option is only available if Bypass VGA Palette to Enable Use of 16 Grays is selected in the
Display: VGA Palette dialog box and you are on a 16-Color display mode.

5. You may enter a description to the album (this is optional and will remain blank unless you assign a
description to the album).

6. Click OK. The dialog box closes and changes the properties of the album.

o=

Related topic
3 Album Properties dialog box



= Backing up an album file

Use the Maintenance: Backup command from the Album menu to save an album and all its associated
files to floppy disks or to another drive and directory. You can also choose whether or not to compress
the backed-up files.

1. Select the album you want to back up by clicking on its title bar, or if minimized, double-click on the
album icon.

2. Choose "Maintenance: Backup" to display the Backup dialog box.

3. Use the Directories and Drives list boxes to select the drive and directory to which you want to save
the album.

Important: All files in the target directory will be deleted before backing up begins.

4. Click OK. The dialog box closes and starts saving the album and its associated files. Refer to the
Album status bar to see the progress of the backing up.

Note: Backing up your album will also back up your mark files with the album file itself.

When backing up to floppy disks, you may be asked to insert additional diskettes as they are filled up.
Album splits files so that disks are filled as efficiently as possible.

Related topic
=l Backup dialog box



= Restoring an album file

Use the Maintenance: Restore command in the Album menu to restore a backed up album and its
associated files so that you can use any of the files contained in it. Backed up albums can be restored
to: their original directories, if you have deleted the album file after backing up or to another directory to
avoid replacing any existing files, with the same filename and path.

If you have deleted the album file after backing up, restore the album and its associated files to their
original directories as follows:

1. Choose "Maintenance: Restore" to display the Restore dialog box.

2. Locate the drive and directory containing the album you wish to restore.

3. Click OK and the dialog box closes. Your album and its associated files are restored to the directory
you specified, and the album appears in the Album workspace.

Related topic
3 Restore dialog box



= Deleting an album

To remove an album from the workspace use the Remove command in the Alboum menu. You can
reopen the album file later to bring it back to the workspace. To place it on the shelf, drag it on to the

Shelf. To delete the album file from disk use the Delete command from the Maintenance submenu in
the Album menu.

1. Select the album you want to delete by clicking on its title bar, or if minimized, on the album icon.

2. Choose "Delete" from the Maintenance submenu in the Album menu. A message appears to confirm
if you wish to continue.

3. Click on "Yes" if you are sure of deleting the album file or "No" if you change your mind.
Note: You can delete the album file with the Delete button in the Shelf dialog box. Album cannot
undo "Delete" and you cannot recover albums or files unless you have backed them up.

Related topic
=l Shelf dialog box



# Getting information

There are several ways to view information about albums and the files associated with the thumbnails it
contains. To learn how to access this information, click on the appropriate button.

= File Information
=l Album Information




# Album information

The Album Information dialog box contains information about the selected album. There are several
ways to access the Album Information dialog box:

= in the Open dialog box, select an album and click on the Info button.

= in the workspace, select the album you want information on by clicking on its title bar or icon, then
choose "Album Information" from the View menu.

3 in the Restore dialog box, click on the Info button.

= in the Shelf dialog box, select an album from the Albums in Workspace or Albums on Shelf list

boxes and click on the Info button.
= in the Album Properties dialog box, click on the Info button.




#l File information

Once afile is inserted into an album, some information is collected. Following are ways by which you
can view this information:

= selecting a thumbnail and choosing "File Information" from the View menu displays the File
Information dialog box.

viewing filenames instead of thumbnails in an album displays information to the right of the
filename.
= clicking on a thumbnail or filename with the right mouse button displays the file information box.




& Using Album's shelf

The albums you place on the shelf remain there until you want to use them again. To use an album from
the shelf:

—_

. Click on the shelf button in the toolbox. The Shelf dialog box appears.
2. Select the album you want to use from the Albums on Shelf list box by clicking on it.

3. Click on "<=" or double-click on the selected album. The album is transferred to the Albums in
Workspace list box and appears as an icon in your Album workspace.

4. Double-click on the album icon to display the album.

Related topic
= Shelf dialog box



= Exiting Album

Use the Exit command in the Album menu to exit Album. You can also exit by:

= double-clicking on Album's control-menu box.
clicking on Album's control-menu box and choosing "Close".
= if Album is minimized, clicking once on the icon and choosing the Close command from the menu

which appears.




&l Placing thumbnails of files into albums

There are several ways to insert thumbnails of files into albums.

= inserting files

= moving thumbnails within or between albums
= using the "drag-and-drop" feature

= using "Save to Album" in the Save As dialog box




=l

Inserting files

Use the Insert command from the Thumbnail menu to insert files or application-linked files. This
procedure explains how to insert thumbnails of files from a specific directory.

1.

Choose "Insert" to display the Insert dialog box.

2. Decide to insert thumbnails of a media type available or all formats in the List File Types of Media
Type list box.
3. Select a file extension from the list of file types.

4. Locate the directory containing the file you want to insert using the Directories and Drives list boxes.
5. Click on a filename in the File Names list box to select it and then click on the Insert button. (You can
select multiple files by clicking and dragging down the list in conjunction with the CTRL or SHIFT

keys.) The thumbnail of the file appears in the specified album.

6. To automatically insert thumbnails of all files in a specific directory and its subdirectories select
"Include all Subdirectories".

7. Select "Write Errors and Journals to File" to write any error messages to the Journal.txt file in the
Windows directory.

8. In the Insert Files to Album, specify the album into which you want to insert the thumbnails.

9. Click on the Close button. The dialog box closes.

Related topic

= Insert dialog box



& Copying thumbnails

Use the Copy: Thumbnail command in the Edit menu or drag-and-drop thumbnails with the CTRL key
held down, to create duplicates of the thumbnails in another album.

Select the thumbnails you wish to copy from the active album.
Choose "Copy: Thumbnail" in the Edit menu. The selected thumbnails are copied onto the clipboard.
Open the album into which you want to copy the thumbnails.

Choose "Paste" from the Edit menu. The thumbnails are inserted in the positions determined by the
album's current sort mode.
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& Viewing thumbnails

Use the Files command in the View menu or double-click on the thumbnail (or filename) to view or play
the original file associated with one or multiple thumbnails. Depending on the file type, the file is
displayed in its appropriate viewing window.

Image and Graphic files

Image and graphic files are displayed in the Viewer program. You can even view multiple files to
compare the files with one another. Refer to the Viewer Help for more information on its commands.
Audio files

Audio files such as WAV, MIDI and RMI files are played in Microsoft's Media Player. Refer to the
Windows documentation for more information on Media Player.

Video and Animation files

Video (AVI) and animation (FLC, FLI, FLX) sequences are played in Microsoft's Media Player.

Application-linked files

Application-linked files are displayed in the application to which they are associated. For example, if you
double-click on a PageMaker file, PageMaker runs and opens the file.

Related topic
= File Formats



&l Selecting thumbnails

Before applying commands to individual thumbnails in an album, you first have to select them. When a

thumbnail is selected, the file is highlighted. You can select thumbnails or filenames in the following
ways:

= To select one, simply click on it. Any other selected thumbnails in the album are deselected.

= To select a range, click on the first in the range, then press the Shift key down and click on the
last one.

= To select or deselect individual thumbnails without affecting previous selections, hold the CTRL

key down and click on a thumbnail.
Choose a Select command from the Edit menu.
= Choose the Select action in the Search dialog box after defining the search criteria.




& Arranging thumbnails

Initially, thumbnails are arranged in an album in the order they were inserted. New thumbnails are
always inserted at the end of the album. You can change the order in an album by:

Moving thumbnails from one location to another

Moving thumbnails onto the clipboard

Deleting thumbnails from an album

Arranging thumbnails in alphabetical or numerical order
Retaining the current arrangement of thumbnails for future use
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Related topic
3 Copying thumbnails



&= Changing thumbnail properties

Use the Properties command in the Thumbnail menu to change the keywords, subject or descriptions of
thumbnail files.

—_

. Choose Properties in the Thumbnail menu to display the Thumbnail Properties dialog box.

2. Select a keyword from the drop-down list of Keywords. If there are no keywords here, you have not
yet assigned keywords to the album.
Note: You can also assign a keyword by typing a new keyword here and pressing Enter.

3. The keyword appears in the Keywords list box above it. To remove the keyword from this list box
press "Remove".

4. Type in a subject (up to 127 characters) and description (up to 4095 characters). These are optional
and will remain blank unless you assign a subject or description.

5. Click OK. The dialog box closes and saves the new properties.

Related topics

3 Thumbnail Properties dialog box
3 Keywords dialog box



& Relinking thumbnails and files

Use the Relink command in the Thumbnail menu to locate and re-establish the link between the
thumbnails and their files. You can identify which thumbnails need relinking by clicking on the thumbnail
or filename with the right mouse button. If the flename shown at the top of the information box is grayed
out, the thumbnail has lost track of the file. If you have selected "Enable Automatic Checking of Source
File", files are automatically checked and crosses the index number. However, this will slow down the
operation and repainting of thumbnails.

Select the thumbnails that need relinking.

Choose "Relink" to display the Relink dialog box.

Select the new drive to which you want to relink the thumbnails to from the Drive options.

Select the Directory option button - a text cursor appears in the text box.

Enter the full path of the directory in which the selected thumbnails' files are now located. (If they are
now on a different drive, the path should start with the drive letter. If they are on the same drive, the
drive letter may be omitted).

6. Click OK. The dialog box closes and relinking starts. The thumbnails are all compared against the
files present in the new location, their paths are updated and if necessary, so too are their
thumbnails and information.
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Related topic
3 Relink dialog box



# Changing other types of thumbnails

When placed into an album, application-linked files use their linked application's icon (if it is available)
as their thumbnail. This thumbnail and other types of thumbnails can be changed with the Update: From
Clipboard command in the Thumbnail menu. This command is useful for replacing the thumbnail with
something more meaningful from the clipboard, such as a screen capture of the file displayed in its
linked application.

1. Double-click on the thumbnail of an application-linked file. The file's linked application is invoked and
opens the file.

2. Click on the application's maximize button to fill the screen.

3. With the ALT key held down press the Print Screen key. The screen is captured to the Windows

clipboard.

Close the application and return to Album.

5. With the thumbnail of the file selected, choose "Update: From Clipboard". The file's thumbnail is
regenerated from your screen capture.

&

Note: The "NO ICON" thumbnail is displayed if an inserted file's file extension is not associated with an
application or the application's icon is unavailable or unreadable.




= Converting between file formats

Use the Convert File Format command in the File menu to convert image and graphic files from a
variety of file formats to a common one. The files of the thumbnails you choose may all be of the same
format or different ones.

When converting image and graphic files, you have the options of deleting the original files, where to
save the converted files and inserting the new files into an existing album.

Select the thumbnail whose file you want to convert.
Choose "Convert File Format" to display the Convert File Format dialog box.
Choose a file format to convert to in the "Convert Image/Graphic Files to" list box.

Decide where you want to save the converted files. If you select "Another Subdirectory”, type in the
path and directory in the text box.

5. Select "Delete Files and Remove From Album", if you want to delete the original files from disk and
the album.

6. Select "Insert Converted Files to Album" if you prefer to insert the converted files into an album in the
workspace.

7. Click OK. The dialog box closes and file conversion begins.
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Related topics
3 File Formats
= Convert File Format dialog box



# Converting between data types

Use the Convert Data Type command in the File menu to convert the data type of image and graphic
files. You cannot convert files to the selected data type whose file formats do not support the data type.

When converting the data type, you have the choice of overwriting the original files or creating new files
into an existing album.

Select the thumbnail whose file you want to convert.
Choose "Convert Data Type" to display the Convert to Data Type dialog box.
Choose a data type to convert to in the "Convert Image/Graphic Files to" list box.

Decide where you want to save the converted files. If you select "Create New Files in Subdirectory",
type in the path and directory in the text box.

5. Select "Insert Converted Files to Album" if you prefer to insert the converted files into an album in the
workspace.

6. Click OK. The dialog box closes and conversion begins.
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Related topic
= Convert Data Type dialog box



&= Moving files

Use the Move command in the File menu to move selected files in an album to the target directory.
Whether you are moving files off your hard disk to make space, or you want to make the files available
to other users on a network, you will find moving is an essential file management operation. Moving files
is similar to copying but it does not retain the original files.

1. Select the thumbnail whose file you want to move.
2. Choose "Move" in the File menu to display the Move Files dialog box.

3. Locate the drive and directory into which you want to move the files. Use the Browse button if you
want to view the files existing in that directory.
4. Click OK. The dialog box closes and the selected files are moved.

Related topic
= Move Files dialog box



&= Copying files

Use the Copy command in the File menu to copy the selected files in an album to the target directory.
You also have an option to insert the copied files into an album in the workspace.

1.

Select the thumbnails whose files you want to copy.

2. Choose "Copy" in the File menu to display the Copy Files dialog box.
3. Locate the drive and directory into which you want to copy the files. Use the Browse button if you
want to view the files existing in that directory.
4. Select "Insert Copied Files to Album" if you prefer to insert the copied files into an album.
5. Click OK. The dialog box closes and starts copying the selected files.
Related topic
= Copy Files dialog box



= Renaming files

Use the Rename command in the File menu to rename a file. Album allows you to easily change
filenames.

—_

Select the thumbnail of the file you wish to rename.

2. Choose "Rename" to display the Rename Files dialog box.

3. Type in the new name for the selected file in the To text box. The From text box shows the old
filename.
Note: You cannot rename files to a different file extension. But, you can rename files having the
same filename but different extensions.

4. Click on OK. The dialog box closes and the file is renamed.

Related topic
3 Rename Files dialog box



# Changing file attributes

Use the Attributes command from the File menu to change the information displayed about a file. This
information indicates if the file is read only, hidden or system and whether it was modified since the last
back up. To change the file attributes:

1. Select the files for which you want to change the file attributes.

2. Choose the Attribute command to display the Attributes dialog box.
3. Check or uncheck the boxes of the attributes you want to change.
4. Click OK. The dialog box closes and the new attributes are set.

Related topic
= Attributes dialog box



&l Changing file association

Use the Associate command from the File menu to associate a file to a program so that you can directly
run the file in that program by just double-clicking on the file's thumbnail. For instance, if you associate
the .TXT extension to Notepad, double-clicking on a .TXT thumbnail will open that file in Notepad. To
associate a file:

—_

. Select the thumbnail for which you want to associate a program.
2. Choose the Associate command to display the Associate dialog box.

3. The selected thumbnail's extension appears in the Files With Extensions text box. You can type in a
different file extension if you want to change it.

4. In the Associate With Program list box, select the program to which you want to associate the
extension. You can type the name of a program file if it is not listed in the list box.

5. Click OK. The dialog box closes and the file is associated to the program.

Note: If you want to remove an association of a file, you can do so with the Associate command. In
the Associate With Program list box, choose None and the file is no longer associated to a program.

Related topic
3 Associate dialog box



&l Creating a slide show

The slide show feature allows you to display image and graphic files from an album with any one of
eighteen different transition effects. The transition effect controls the way the slides are replaced. Each
file is displayed at its actual view, centered on a black background until it is replaced by the next one in
the presentation.

1.

2.

No ok

Within an album, select the thumbnails of image or graphic files you wish to display. If no thumbnails
are selected, all qualified files associated with thumbnails are displayed.

Choose "Slide Show" from the View menu. The Slide Show dialog box appears.

In the Transition group box, select a transition effect and whether you want to change the slides
automatically (specifying the delay time), manually or synchronized with audio files.

Note: If you selected "Synchronize With Audio Files" the delay time will still be in effect.

Click on the Text button to display text information and change the text attributes or color.

Click on the Bkgd Color button to change the background color.

Click on the Bkgd Music button to choose the MIDI files to be played during the slide show.
Click OK. The dialog box closes and displays the thumbnails in a slide show.

If you selected automatic display, the slide show starts. If you selected manual display, the Slide
Show Controls dialog box appears displaying the manual controls. Click OK to begin the slide show.

Note: Application-linked files cannot be displayed in slide shows.

Related topics
3 Slide Show dialog box

£

Slide Show Control dialog box



# Customizing the Toolbox

The toolbox can be customized with the tool button located below the shelf. Choose the programs
which appear and how they are displayed. You can customize the toolbox by:

= Adding a program
Removing a program

=
3 Changing the properties of a program
= Configuring the programs




& Adding a program

Adding frequently used programs into the toolbox makes it easier for you to transfer between Album
and those programs. Once a program icon appears in the toolbox, simply click on it to open the
corresponding application, or drag-and-drop a thumbnail onto the program icon to open the file in that
application.

1.

w

Click on the tool button in the toolbox and choose "Add" from the tool menu. The New dialog box
appears.

Select the Program group option and type in a group name. Click on the New button to create the
new group. You can have as many program groups as you want but only one will be used as default.
In the Program icon option, enter a description, the command line and the working directory.

. Click on the New button. The program icon with the name you specified or its default name appears

in the toolbox.
Click on the Close button. The dialog box closes.

You can easily add programs by dragging execution files from the File Manager to the toolbox.

Related topic
= New dialog box



# Removing a program

The toolbox can contain many program icons, but we suggest you limit the programs to only those you
frequently use. To remove program icons from the toolbox:

1. Click on the tool button in the toolbox and choose "Delete" to display the Delete dialog box.
2. Select "Delete Current Program Group" if you want to remove the current program group.
3. Select a program item from the Icon list box to remove the program from the toolbox.

4. Click OK. The dialog box closes and the selected program disappears from the group.

Related topic
3 Delete dialog box



& Changing the properties of a program

Use the Properties command from the tool menu to change the program name, description, command
line and working directory of a program.

1. Click on the tool button in the toolbox and choose "Properties" to display the Properties dialog box.
2. Change the name, description, command line, or working directory.
3. Click OK. The dialog box closes and the properties are modified according to your changes.

Related topic
= Properties dialog box



=l

Configuring the programs

Use the Configure command in the tool menu to position the toolbox on the left, right or anywhere within
the workspace. You can also specify the number of icons to show on the toolbox.

1.

w

Click on the tool button in the toolbox and choose "Configure" to display the Configure dialog box.
You can also double-click on an empty space in the toolbox to open the same dialog box.

Choose the position of the toolbox.

Select "Show Names" if you wish to display the names of the programs.

Define the number of icons to be displayed on the toolbox.

The scroll arrow button can be used to display the other icons in the program group.
Click OK. The dialog box closes and changes the toolbox settings.

Related topic

£

Configure dialog box



Shelf

The shelf, at the top of the toolbox, provides a place to store albums. It can contain up to 140 albums
and can be used to find albums, whether they are on the shelf or in the workspace. The albums in the
workspace can be placed onto the shelf in any of the following ways:

= Drag an album icon onto the shelf.
= From the Shelf dialog box, select the album you want to place onto the shelf from the Albums in
Workspace list box, then click on "=>".
Click on an album's control menu box and from the menu, choose "Put on Shelf".
= Use the Batch Manager's Put on Shelf operation.

Related topics

= Shelf dialog box
Using Album's shelf



%l Tool button

The tool button is located below the shelf in the toolbox. Use this to add any number of groups to the
toolbox to organize your programs as you wish and to choose the program items which appear and how
they are displayed in the toolbox. When you click on this button, the tool menu drops down containing
all the commands that can be applied to customize the toolbox.

= New creates a new group in which you can add programs you want to insert in the toolbox
= Delete removes the current program group or selected program item. The program and data files
of the deleted program will remain on your hard disk

Properties changes the properties of a program in the toolbox
= Configure allows you to change the location of the toolbox and set the number of programs in
the toolbox

Run allows you to start an application
= Close hides the toolbox




=l

Defining keywords

Keywords are like index entries which help you to search for thumbnails in your album. A keyword could
consist of one word or more (separated by spaces) but only up to 31 characters. Before you assign
keywords to your thumbnails, you should first define some keywords for the album as follows:

1.
2.

Select " Keywords" from the Album menu to display the Keywords dialog box.

In the New Keywords box, enter a keyword and press Enter or the Add button. The new keyword
appears in the list box below.

To change or remove the keyword use the Change or Remove buttons.

If you wish to bring in keywords from other albums in your workspace, choose the album from the
Adopt Keywords From Album list box. You will be asked if you want to retain your old keywords and
append the new ones.

. You may load a list of keywords saved to a file using the Load button. The Save button will save the

list of keywords to a file on disk.

Note: In the Load and Save Keywords dialog boxes, you can use the DOS or Windows Text file
format. Choosing the appropriate file extension allows you to convert files from DOS to Windows and
vice-versa.

Click OK. The dialog box closes and the new list of keywords appears in the Search Ribbon and the
Thumbnail Properties dialog box.

Once you have defined keywords for an album, you can assign keywords to thumbnails using the
Thumbnail Properties dialog box.

Related topics
= Keywords dialog box
3 Thumbnail Properties dialog box
= Changing thumbnail properties



Defining search criteria

Search criteria are options based on which Album searches for thumbnails. These can be keywords,
subject, description, filename or any other options. After you select a criteria, you can define the
conditions for that criteria. For example, when you search by keywords you could define some
conditions as follows:

red OR blue AND yellow,
NOT red OR blue,

NOT (red AND blue),

"red" OR "black and white"

Note: Use double quotation marks ("...") to enclose words to be treated as one word.
Boolean Operators

Multiple conditions are specified by using the Boolean (or logical) operators, AND, OR, and NOT and
().

AND allows you to define logical conjunction. For example, specify "red AND blue" Album searches for
all files that are both "red" and "blue".

OR is used to perform logical inclusion. For example, specify "red OR blue" and Album searches for
files that are "red" or "blue".

NOT is used to perform logical negation. For example, specify "red" and double-click on the NOT
operator. Album selects all files that are not "red".




=l

Searching for thumbnails

In Album, if you are managing a large number of files, you may forget exactly where you have placed a
particular one. You can search for thumbnails in the active album by using its keywords, marks, subject
or by defining your own search criteria. The procedure below explains how to search by using your own
search criteria.

—_

. Choose "Search" to display the Search dialog box.

2. In the Search Criteria group box, select a search criteria from the list box and define the search
condition. Press the Add button to add it to the list box below.
To change or remove the search condition, press the Change or Remove button.
3. Select "Search All Albums in the Workspace" if you want the search to be done on all albums in the
workspace.
4. Choose View, Select or Go To to display, select or go to the thumbnails matching the search
condition.
5. Enter a query name in the Queries combo box (press Enter to include it in the list box) or choose an
existing one. The query will appear in the Search by Queries submenu.
6. Click OK. The dialog box closes and thumbnails matching the conditions are displayed.
Related topics
= Search dialog box
= Defining search criteria
= Defining Queries



= Defining queries

Use the Search command from the Thumbnail menu to add or remove queries to the queries list which
appears in the Search by Queries submenu. These queries are predefined search criteria which can be
used to search for thumbnails matching their search conditions. To define a query:

1.
2.

Choose "Search" to display the Search dialog box.

In the Search Criteria group box, select the search criteria and add it to the list box by pressing the
Add button.

To change or remove this search condition, press the appropriate button.

Select "Search All Albums in the Workspace" if you want the search to be done on all albums in the
workspace.

Choose the action to display the thumbnails after a search has been done.

Enter a query name in the Queries combo box. Press Enter to include it in the drop-down list box.
The query appears in the Search by Queries submenu.

Click OK. The dialog box closes and thumbnails matching the conditions are displayed.




& Using the Mark Palette

Marks serve as labels for thumbnails in albums so that you can easily locate your files. You can assign
26 marks to each thumbnail. These marks are shown by letters A to Z above each thumbnail after its
index number. By double-clicking on a mark or choosing "Edit" in the control menu (available only when
not assigning marks), you can open the Edit Marks dialog box in which you can edit the mark names.

3 Assigning marks

= Editing marks

= Loading and saving marks

= Converting marks to keywords

Related topics
= Mark Palette
3 Edit Mark dialog box



= Assigning marks

Marks can be assigned to a thumbnail in an album and more than one thumbnail can have the same
mark. To assign marks to a thumbnail:

1. Choose the marks you want to assign from the mark palette. Each mark is represented by a letter.
You can select multiple marks by clicking on a mark and holding the SHIFT or CTRL key down.

2. Press the Assign button. The button toggles to "Stop" and the pointer changes to a mark pointer.

If you decide to change the marks selected in the mark palette, simply click on the marks to change
them.

3. Click on the thumbnails you want to assign the selected marks. Depending on whether you are
viewing thumbnails or filenames, letters representing marks appear on the top of the thumbnail
frame or on the left of the filename after the index number.

4. Press the Stop button to stop assigning marks.

Related topic
= Mark Palette



&l Editing marks

Use the Edit command in the mark palette control menu to edit marks.

1.
2.
3.

Choose "Edit" or double-click on the mark name to display the Edit Marks dialog box.
Select a mark from the Mark Name list box.

Enter a new name in the Mark Name text box. The name appears simultaneously in the list box
below.

If you want to use marks from another album, select an album from the Adopt Marks From Album list
box.

Press the Clear All button if you want to remove all marks in the Mark Palette.
Click OK. The dialog box closes and the new marks appear in the Mark Palette.

Related topic

£

Edit Mark dialog box



# Loading and saving marks

Once you have assigned mark names for an album you can save them to a file on disk using the Save
command in the mark palette control menu. In future, you can load this file using the Load command to
assign these marks for another album.

1. Choose "Load" or "Save" to display the Load Marks or Save Marks dialog box.
2. Select the Mark File (*.MRK) extension to display only the mark files.

3. Use the Directories and Drives list boxes to locate an existing mark file or, if saving, the directory to
which it will be saved.

4. Select the file you wish to load from the File Name list box. When saving, enter a filename or, if you
wish to overwrite an existing file, select its filename from the filenames list box
Note: When loading a file, you have the options to merge or replace the original marks of an album.
5. Press the Browse button if you want to search for files.
6. Click OK. The dialog box closes and the appropriate file is loaded or saved.

Related topics

= Load Marks dialog box
= Save Marks dialog box



&= Converting marks to keywords

Use the Convert to Keywords command in the mark palette control menu to convert marks into
keywords with the options to remove the marks from selected thumbnails or the mark palette.

1.

5.

Select the thumbnails from which you want to remove specified marks and the marks in the mark
palette which you want to convert to keywords.

Choose "Convert to Keywords" in the to display the Convert to Keywords dialog box.

Select "Clear Marks From Selected Thumbnails" if you wish to remove the marks from selected
thumbnails after converting marks to keywords.

Select "Clear Mark Names From Palette" if you wish to clear all the existing marks from the mark
palette after converting marks to keywords.

Click OK. The dialog box closes and marks are converted to keywords.

Related topic

=l

Convert to Keywords dialog box



= Drag-and-drop operations

Drag-and-drop is a powerful technique to transfer information between programs and shift the focus of
your work. One that you will use most often is dragging and dropping a single thumbnail or multiple
thumbnails onto an icon in the toolbox to invoke the program and given that the file is compatible, the
thumbnails are opened in the program's workspace. In this way, you can very quickly select, open and
edit multiple images. The other drag-and-drop operations you may often use are:

To add programs from File Manager to Toolbox

1. In File Manager, select the execution files (*.EXE) you want to add to the toolbox. You can select
multiple files by pressing the CTRL or SHIFT key down and clicking on the files with your mouse.

2. Drag the files from File Manager and drop them onto the toolbox. The pointer changes into a file
icon.

Make sure the files are dropped onto the toolbox.
3. The program icons appear in the toolbox.

To insert album files into the Album workspace

1. In File Manager, select the album files (*.ABM) you want to insert into the Album workspace. You can
select multiple files by pressing the CTRL or SHIFT key down and clicking on the files with your
mouse.

2. Drag the files from File Manager and drop them into Album's workspace. The pointer changes into a
file icon.
Make sure the files are dropped on an empty area of the Album workspace.

3. The album appears in the workspace.

To insert thumbnails into an album

1. In File Manager, select the files whose thumbnails you want to insert into an album. You can select
multiple files by pressing the CTRL or SHIFT key down and clicking on the files with your mouse.

2. Drag the files from File Manager and drop them into an album. The pointer changes into a file icon.
Make sure the files are dropped on an album.

3. The thumbnails appear in the album.

To copy or move files between albums

1. Select the thumbnails you want to copy or move to another album. You can select multiple
thumbnails by pressing the CTRL or SHIFT key down and clicking on the thumbnails with your
mouse.

2. Drag the thumbnails and drop them into another album. The thumbnails are moved to the other
album.

3. Pressing the CTRL key down while dragging and dropping the thumbnails will copy the thumbnails in
the other album.
Make sure you drop the files to the right album.

4. The selected thumbnails appear in the target album.

To embed or link files in other applications

1. Select the thumbnail you want to embed or link in the client application.

2. Drag-and-drop it to another application such as, PhotoStyler, Image Editor or Word for Windows.

3. The file is embedded or linked depending on the settings you have chosen in the OLE & Clipboard
dialog box.

Note: Pressing the SHIFT key while dragging and dropping will always embed the file whereas,
pressing the CTRL key will always link the file in the client application.




= Object Linking and Embedding

Linking and embedding objects can vary from program to program. Before you do this we suggest that
you read your client's program documentation.

Basically there are two routes to embedding a file. One starts from the client application, the other from
the server. Linking always starts from the Server. To embed or link objects starting from the:

3 Client
= Server




# Embedding from the Client

To embed an object starting from the client:

1. Open a document in the client application and select the client's Insert Object command (or similar).
The Insert Object dialog box appears.

2. In the Object type list box, select Ulead Album Clip or Ulead Image Editor Image to embed or link an
object.

Click OK. The dialog box closes and MediaStudio Album or MediaStudio Image Editor appears.
Select the album containing the thumbnail of the file you want or select the image in Image Editor.

5. From Album's Album menu or Image Editor's File menu, choose Update client (client is the name of
the client application).

6. Either Exit Album, Image Editor or switch to the client application. The object you selected appears
in the document of the client application's workspace.
Note:

In Album the Update command is disabled if you are not in OLE session (i.e. there is no client program),
or there are no qualified thumbnails or more than one qualified thumbnail is selected.

B w

A faster way to embed is by dragging and dropping a file from Album to a compatible program, with the
SHIFT key held down or pressing the CTRL key for linking. If you do not press the SHIFT or CTRL key
down, the drag-and-drop setting in the OLE & Clipboard dialog box will determine the embedding or
linking operation.

Related topic
3 OLE & Clipboard dialog box



= Embedding or linking from the Server

To embed or link an object starting from the server:

1. Starting from Album or Image Editor, select the album containing the thumbnail of the file you want
or open the image file in Image Editor.
For linking, ensure that the correct options are selected in the OLE & Clipboard dialog box. For
Image Editor, select "Include OLE-Related Formats or, in Album, select "OLE Linking Format".

2. From the Edit menu, select "Copy: File" (in Album), or "Copy" (in Image Editor).

3. Exit Album or Image Editor and open the client application containing the document into which you
want to place the object.

4. Select the client application's Paste Special command. The Paste Special dialog box appears.

5. In the Data Type list box, select the appropriate data format.

6. Click on Paste or Paste Link. The dialog box closes and the object is embedded when you press the
Paste button or linked when you click on the Paste Link button.

Note: In some client applications, you can use their normal Paste command to embed an object.

A faster way to embed is by dragging and dropping a file from Album to a compatible program, with the
SHIFT key held down or pressing the CTRL key for linking. If you do not press the SHIFT or CTRL key
down, the drag-and-drop setting in the OLE & Clipboard dialog box will determine the embedding or
linking operation.

Related topic
3 OLE & Clipboard dialog box






